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Summary

In this CNA Information Memorandum (CIM), we present a primer
on ground combat models with brief reviews on Lanchester-type attri-
t ion  equat ions  and  how CNA used  a  mul t i agent -ba sed
model, EINSTein1, to study small-unit ground combat tactics.

The U.S. Department of Defense (DoD) uses many types of models in
applications ranging from acquisition, weapon system design, test
and evaluation, training, tactics development, etc. However, it is
widely accepted that “all models are wrong, and some are useful.”
This can be mostly attributed to the emphasis of many current
combat models on modeling software and computer hardware while
neglecting the proper application of fundamental military science
[1]. For example, many combat models incorrectly use Lanchester-
type equations to calculate force-on-force attrition when the assump-
tions of the Lanchester equations are not appropriate for the models. 

Compared to many conventional deterministic models, agent-based
models offer a new approach to improve our understanding of com-
bat. By specifying a set of simple inter-agent relationships, one can
access complex behavior space that emerges from multiple runs of an
agent-based model and gain insights not available through the con-
ventional models. 

Recent CNA ground combat studies using EINSTein examined a wide
range of small-unit scenarios and showed EINSTein to be an efficient
and effective analysis tool. For interested readers, we provide a quick
guide to EINSTein and walk though several examples to show the var-
ious features of the software toolkit. 

1. EINSTein refers to Enhanced ISAAC Neural Simulation Toolkit, and
ISAAC stands for Irreducible Semi-Autonomous Adaptive Combat.
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EINSTein and its predecessor ISAAC have opened a new chapter in
military operations research and have inspired many other models
based on the same mathematical foundation. As the tools improve
and evolve, they will provide novel approaches for a better under-
standing of the complex dynamics of combat.
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Introduction

Many readers may be familiar with classic works on warfare, such as
The Art of War by Sun Tzu in sixth century B.C. China and Carl von
Clausewitz’s On War in 19th century Prussia. For as long as there has
been warfare, humans have tried to understand the essence of this
complex social phenomenon. Today, practitioners of military sci-
ences continue to search for ways to better understand the complex
dynamics on a battlefield and improve their chances against potential
foes. 

This has led to the birth of a new branch of military operations
research, the application of complexity theories to ground combat
models. In the forward section of the book Artificial War by Andrew
Ilachinski, retired Marine Corps LtGen Paul K. Van Riper recalls the
Marine Corps’s role in this effort[2]: 

The United States Marine Corps in 1994 undertook a wide
review of new discoveries seeking those that showed prom-
ise for improving the profession of arms. ‘Casting their nets
widely’ and looking far beyond the usual interest of military
personnel, a handful of Marine officers—of which I was for-
tunate to be included—learned of the emerging field of
nonlinear dynamics, more popularly known as the science
of chaos or complexity.

Soon after LtGen Van Riper took over as the Commanding General
of the Marine Corps Combat Development Command (MCCDC) in
1995, he established the Office of New Sciences to explore military
applications of novel scientific theories. He eventually approached
Andrew Ilachinski at CNA to conduct “research on the relevance of
complexity theory to land combat.” The result of that collaboration
was the groundbreaking multiagent-based model Irreducible Semi-
Autonomous Adaptive Combat (ISAAC). Encouraged by the prelimi-
nary success of ISAAC, Ilachinski developed the Windows-
based EINSTein (or Enhanced ISAAC Neural Simulation Toolkit).
The software toolkit has been continuously updated over the years
and used in a series of CNA studies on ground combat.
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In this CNA information memorandum (CIM), we provide a primer
on ground combat models starting with a discussion on the various
different types of models. We then briefly review a few combat models
currently used by the DoD community. Because many of these models
use Lanchester-type equations in their attrition calculations, we
explore a few examples of these equations. However, because of the
inherent limitations of the Lanchester-type equations, they are ill-
equipped to model many real-world scenarios. In contrast, multi-
agent-based models like EINSTein have been shown to offer novel
approaches to better understand warfare. We also review a recent
series of CNA ground combat studies (GCS) using EINSTein2 and
provide a primer on using EINSTein along with some sample scenar-
ios for interested readers to get started quickly on using the software. 

Models and simulations defined

The terms “model” and “simulation” are often used interchangeably.
However, DoD presents much stricter definitions that differentiate
the two terms. According to [3], a model is defined as “a physical,
mathematical, or otherwise logical representation of a system, entity,
phenomenon, or process.” A simulation is “a method for implement-
ing a model over time.” Modeling and simulation (M&S) are defined
as “the use of models, including emulators, prototypes, simulators,
either statically or over time, to develop data as a basis for making
managerial or technical decisions.” The key difference between
models and simulations in the DoD context is the time variable. One
may think of a picture as a model, where elements of the picture
depict some real-world objects. A series of pictures played over time
(i.e., a simulation) tells a story about these objects. 

Figure 1 shows the various types of modeling methods and how they
may be classified. 

2. We focus on the period from 2003 to 2006. Ilachinski summarized prior
CNA work from 1996 to 2003 in his book Artificial War [2]. 
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While real-world warfare is often classified as either defensive or
offensive [4], models are rarely defined in such terms. Models shown
in figure 1 are based on a much broader definition than the DoD ver-
sion. They can be classified according to their:

• Degree of abstraction (e.g, from field exercises to abstract the-
ories and analytical equations, shown in black in figure 1)

• Resolution and scale (e.g., from an individual soldier to an
entire army, shown in green in figure 1)

• Type (e.g., deterministic vs. stochastic or logical process models
vs. artificial intelligence models, shown in blue in figure 1)

• Mission (e.g., design, acquisition, tactics development, train-
ing, etc., shown in red in figure 1).

Figure 1. Various dimensions to modelinga

a. Source: Andrew Ilachinski. Modeling and Simulation: An Analyst's Perspective (The Good, Bad, Chaotic, and 
Complex), Aug 2006 (CME D0014738.A1)
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In terms of the degree of abstraction of models, the most concrete
(and least abstract) are military field exercises and experiments. They
provide the most realistic simulations for real-world operations. How-
ever, they provide limited opportunities for analysis due to high costs3

and various artificialities.

At the other end of the spectrum, an analyst can use a set of analytical
equations such as the Lanchester-type equations to quickly estimate
attrition numbers for real-world operations; however, these equations
are often too abstract and have too many simplifying assumptions to
provide realistic results. 

Computerized models fall somewhere in the middle. Most DoD
models and multiagent-based models belong to this category, and
they will explored in more detail later. 

History of modeling

We present here an abbreviated history of combat models. Others
have written extensively on this subject, and we recommend that
interested readers check out The Art of Wargaming by Peter Perla and
Andrew Wilson’s The Bomb and the Computer [6, 7]. When models are
discussed, a computer model often comes to mind. However, long
before computers were used, board game-style wargames, made of
wood and stone, were invented to simulate land warfare [6]. We
begin our discussion of the history of combat models with these ear-
liest board games. 

Wargames in wood and stone

The essence of warfare was captured in board games like the Indian
game Chaturanga (the predecessor of today’s chess) and Wei Qi in
ancient China [6]. Both games are high abstractions of warfare and
were played using fairly simple rules. Since most readers are probably
familiar with chess, we elaborate more on the rules of Wei Qi. 

3. In 2002, the three-week long exercise Millennium Challenge involved
13,500 participants and was estimated to cost $250 million[5].
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Wei Qi can be loosely translated to “game of encirclement”; its origin
goes back over four thousand years [8]. Today, the game is widely
played in East Asia. It is known as Go in Japan and Baduk in Korea. The
game involves two players taking turns to place black or white stones
over intersections of a 19 by 19 grid board. Stones are removed from
the board when they are deemed to have been surrounded (i.e.,
“encirclement”) and can no longer “maneuver.” The player whose
stones occupy the larger territory on the board at the end wins the
game.

The simple rules of these games have remained unchanged for cen-
turies, and these highly stylistic games probably had limited applica-
tions in helping players to understand combat. 

This changed dramatically when in 1664, Christopher Weikhmann
invented the game Koenigspiel, or “King’s Game” (also known as mili-
tary chess). Using chess as a basis, Weikhmann added additional
pieces and roles to the game, and he introduced a die to decide the
outcome of engagements between opposing forces. Koenigspiel revo-
lutionized boardgame-based wargames. For the first time, a game had
enough detail and “hierarchy” to construct models for real-world sce-
narios. Weikhmann remarked, perhaps slightly self-servingly, that the
game “would furnish anyone who studied it properly a compendium
of the most useful military and political principles” [6].

Lanchester-type equations

Developments in science and technology over the next two centuries
created the foundation for the combat models we use today. The next
major step in warfare modeling was developed by the British engi-
neer, Frederick William Lanchester during World War I. Lanchester
devised a series of differential equations to demonstrate the relation-
ships between opposing forces in his publication Aircraft in Warfare:
The Dawn of the Fourth Arm [9].4 Lanchester-type equations are still
used in many of the modern computerized models, and they are dis-
cussed in more detail in the next chapter. 

4. Similar mathematical formulations were put forth by others (Chase and
Osipov) at about the same time. 
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Computerized models

Ever since computers were first used with military models during
World War II, combat models have gained significant capability and
capacity. Mathematical algorithms and computer databases have
replaced wooden boards and dice from an earlier era. Echoing the
earlier classification of models, figure 2 shows the different uses of
models including various computer models [10]. We explore a few of
these models in more detail in the following section.

Survey of combat models

For a comprehensive survey of DoD models, we recommend a 1996
Air Force Research Laboratory report, Warfare Simulations: Status and
Issues for Space, which was updated in 2003 [11, 12]. Information can
also be found at the DoD Modeling and Simulation Coordination

Figure 2. Use of different modelsa

a. Source: Andrew Ilachinski. Modeling and Simulation: An Analyst's Perspective (The Good, Bad, Chaotic, and 
Complex), Aug 2006 (CME D0014738.A1)
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Office (M&S CO5) as it is “the Executive Secretariat for DoD M&S
Management in fostering the inter-operability, reuse, and affordabil-
ity of crosscutting M&S to provide improved capabilities for DoD
operations” [14].

In this chapter, we focus on three ground combat models in use
today. They are One Semi-Automated Forces (OneSAF), the Com-
bined Arms and Support Task Force Evaluation Model (CAST-
FOREM), and the Joint Conflict and Tactical Simulation (JCATS). 

We are limited to fairly abstract descriptions of these models as
opposed to more detailed discussions on their algorithmic founda-
tion. This is due to the limited time and scope of this report and the
difficulty in getting access to the source documents of these models. 

OneSAF

OneSAF is designed as 

a composable, next generation, entity-level Computer Gen-
erated Forces (CGF) simulation designed for brigade and
below, combat and non-combat operations. OneSAF has
been crafted to model detailed buildings for urban opera-
tions including interior rooms, furniture, tunnels and sub-
terranean features [15].

OneSAF models more than 25 sides and forces with asym-
metric side relationships to better model the contemporary
operating environment. As an example, in OneSAF it is pos-
sible to model two tribes that are both friendly to the Blue
forces but are enemies to each other. OneSAF version 1.5,
released on 23 August 2007, incorporates improvements in
the following capabilities: Improvised Explosive Devices
(IEDs), the creation of mouse holes, dynamic side changes,
reduced profile shooting, urban medical evacuation, snip-
ers, projectile penetration of interior walls, conduct raids
and ambushes, shielding tactics, decoys, craters and naval
operations [15].

5. M&S CO is the former Defense Modeling and Simulation Office
(DMSO). Its Essentials of Modeling and Simulation (EMS) web portal
is a good place to start [13]. 
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CASTFOREM

The Combined Arms and Support Task Force Evaluation Model
(CASTFOREM) is: 

the Army’s highest resolution, combined arms combat sim-
ulation model. CASTFOREM is used for weapon systems
and tactics evaluation in brigade and below combined arms
conflicts. The model uses closed-form mathematical expres-
sions, probability distributions, along with an embedded
expert system (which is implemented via decision look-up
tables) to perform some elements of command and control.
It was designed primarily to simulate intense firefights
about 1 to 1-1/2 hours in duration for echelons up to
including brigade. However, because individual scenarios
take about as long to run as the firefights the program is sim-
ulating, it is difficult to conduct any meaningful exploratory
analyses [2].

JCATS

The U.S. Army and Marine Corps have pioneered ground combat
modeling since World War II. As warfare becomes more Joint, the
M&S world is also becoming more Joint. For example, the Joint Con-
flict and Tactical Simulation (JCATS) is managed by the U.S. Joint
Forces Command’s Joint Warfighting Center and was initially devel-
oped by the Lawrence Livermore National Laboratory (LLNL).
JCATS is 

a multi-sided interactive, entity-level conflict simulation
used by military and site security organizations as an exer-
cise driver and a tool for training, analysis and mission plan-
ning. Among the unique capabilities provided by JCATS is
very detailed modeling of small group tactics in rural or
urban terrain modeling day or night operations with artifi-
cial lighting. JCATS also provides dynamic aggregation and
de-aggregation of units during the game, allowing the user
to control large numbers of entities with fewer players.
Because it is a data-driven model, proper data configuration
provides tremendous flexibility in modeling situations or
equipment [16].

JCATS combines the ability to model large 600 kilometers
by 600 kilometers play box scenarios with the detail needed
to handle a hostage rescue situation inside a building. It is
able to dynamically aggregate and de-aggregate units to an
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entity level. This functionality greatly facilitates Distributed
Interactive Simulation or High Level Architecture interac-
tions with highly aggregated models such as the Joint The-
ater Level Simulation. JCATS differs from most other
combat simulations primarily in its terrain and feature rep-
resentations, detailed dismounted infantry and urban fea-
tures and ability to simulate large joint exercises [16].

Limitations of current models

As we mentioned earlier, it was very difficult to get access to the
source algorithmic documents of these models. In rare occasions
where we were successful, we often found that the supporting docu-
ments were lacking in necessary detail. For example, we obtained a
copy of the JCATS algorithm manual from the developers at
Lawrence Livermore National Laboratory, but we found that eight
out of the 15 chapters on the model algorithm were yet to be written,
including the chapter on attrition calculations [17].

The lack of easily accessible documentation aside, Ilachinski summa-
rizes that all of these current models “are very complex, are usually
tied to a small set of specific computing hardware, are difficult to
interface, have limited data collection facilities, and require real-time
(or close to real-time) run times (thus making it effectively impossible
to conduct meaningfully large exploratory analyses of possible behav-
iors)” [2].

Multiagent-based models like EINSTein provide a new class of models
that are “smaller, more tightly-focused models, that can help with
basic concept development and be used to enhance intuition about
fundamental principles and expected behaviors” [2].

Because many DoD combat models rely on Lanchester-type equations
for attrition calculations, we provide a more detailed presentation on
Lanchester-type attrition equations in the next section followed by
the discussion on EINSTein.
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Lanchester-type attrition equations

Ever since they were proposed during World War I, the Lanchester
equations have found wide use and taken many different functional
forms. Although they have simple mathematical formulations,
Lanchester-type equations are quite capable of modeling various
combat scenarios. A caveat is that the equations are based on many
simplifying assumptions that are often not suitable for the problems
they are asked to solve. In the next section, we show a few examples
of Lanchester-type equations. More detailed presentations on this
subject can be found in [18, 19].

Functional forms of Lanchester-type equations

The general form

The general form of Lanchester-type equations may be summarized
as follows: 

In the equations above, the variables R and B represent the size of the
Red force and the Blue force actively engaged in a battle at time t. NR
and NB are positive values that represent the rates of additional Red
and Blue troops that can brought to the battle, respectively. Parame-
ters r, s, v, and u are time-independent parameters. KB and KR are pos-
itive constants referred to as Lanchester attrition rate coefficients
(e.g., KB represents the effectiveness of Blue force firepower against
the Red force).  and  are also positive constants referred to as
operational loss rate coefficients. 

By assigning values of 1 or 0 to r, s, v, u, , and , we can generate
various functional forms of the Lanchester-type equations. In the

td
dR NR KB– Br Rs α R⋅–⋅ ⋅=

td
dB NB KR– Rv Bu β B⋅–⋅ ⋅=

α β

α β
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next section, we present five such functional forms including: the
Square Law, the Linear Law, the Mixed Law, the Logarithmic Law,
and the Morse and Kimball case. 

In all but the last example, we assume NR = NB = 0.

The Square Law

The Square Law is derived from the general Lanchester-type equa-
tions by taking r = v = 1, s = u = 0 and . We get the following
differential equations: 

The Square Law takes its name from the second-order state equation
shown below: 

To illustrate, let us assume that both the initial Red force (Ro) and ini-
tial Blue force (Bo) sizes are 100 (or Ro = Bo = 100) and the ratio of KB
to KR is 1.5 (i.e., the Blue force is 50 percent more lethal than the Red
force). We plot the numerical solutions of the force strength (R and
B) over artificial time steps using MathCAD.6 This is shown in figure
3.

6. The numerical solutions shown here are solved using the rkfixed subrou-
tine in the MathCAD software. The rkfixed subroutine uses a fourth-
order Runge-Kutta integration algorithm with a fixed integration step
size to solve sets of ordinary differential equations. 

α β 0= =

td
dR KB– B⋅=

td
dB KR– R⋅=

KR Ro
2 R2–( )⋅ KB Bo

2 B2–( )⋅=
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The Square Law is often used to model the type of static trench war-
fare that was dominant during World War I. Attrition of the Red force
is directly related to the Blue firepower (expressed as the product of
the number of Blue shooters, B, and their weapons’ effectiveness,
KB). In the example shown above, both forces start with the same
number of troops. However, because the Blue force’s weapon effec-
tiveness is 50 percent greater than that of the Red force, Blue wins the
battle. 

The Linear Law

If we assume r = v = s = u = 1 and  in the general equations,
we get the following differential equations: 

or 

Figure 3. Lanchester Square Law chart
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The mathematical statement above shows that the rate of loss for the
forces is independent of the force size. They are determined by the
attrition rate coefficients, KB and KR. 

The Linear Law takes its name from the first-order state equation
shown below: 

Using the same initial conditions as for the Square Law case, we
assume that Ro = Bo = 100 and KB to KR is 1.5 and plot the numerical
solutions in figure 4. 

The Linear Law form has been thought to most closely simulate con-
ditions of artillery fire on enemy positions or the hand-to-hand
combat in close quarters. The sizes of the forces involved have no
influence on the attrition rates. The only thing that matters is the
effectiveness of the respective weapons used. As shown in figure 4, the
Blue force has a clear advantage because of its superior firepower. By
t = 90, most Red troops are eliminated, while roughly 40 percent of
the Blue force is alive. 

Figure 4. Lanchester Linear Law chart
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The Mixed Law

If we assume that r = v = u = 1, s = 0, and , the generalized
Lanchester-type equations become the equations shown below:

In this example, the Red force attrition equation is identical to the
Square Law. The Blue force attrition, on the other hand, is adversely
affected not only by the number of the Red shooters but also by the
number of the Blue force (as targets). One can consider this as a sce-
nario where the Blue force is being ambushed by the Red force (i.e.,
Red shooters can take aim at Blue targets more easily than the other
way around). 

The Mixed Law takes its name from the mixed first- and second-order
state equation shown below: 

If we assume that both the Red and Blue forces have initial strengths
of 100 as in the previous case, but the ratio of KB to KR is 1 (i.e., Blue
weapons are as effective as the Red ones), the numerical solutions to
these equations would be as shown in figure 5. 

Figure 5. Lanchester Mixed Law chart
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As shown in figure 5, the Blue force is at a significant disadvantage
when being ambushed by the Red force. Although their weapons are
equally effective against each other, the Red force inflicts far greater
damage because of the target-rich environment presented by the
Blue force under ambush. The Blue force is caught by surprise and
can only return fire to the “general area occupied by the Red force”
while the Red force has a full view of the Blue force and can engage
with lethal “aimed fire” [19].

Next, we consider another functional form of the Lanchester-type
equation, the Logarithmic Law. 

The Logarithmic Law 

If we assume that r = v= 0, s = u = 1, and , we get the Loga-
rithmic Law functional form of Lanchester-type equations as shown
below:

It is obvious that the Logarithmic Law takes its name from the state
equation shown below: 

If we assume that the Red force starts with a strength of 30 and the
Blue force starts with 10, and we assume the ratio of KB to KR is 1, we
can plot the numerical solutions of the force strength over time as
shown in figure 6. 
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This form of the Lanchester-type equations may be thought as a
model for the early stages of a small-unit engagement (10-man Red
squad vs. 30-man Blue platoon). During this early stage, both units
were taken by surprise and vulnerable to enemy fire before they
found effective cover. It is a situation in which the larger force pre-
sents more targets to enemy fire. As force vulnerability becomes the
dominant factor in causing losses, a combat unit becomes more inef-
ficient with increasing size [19]. As shown in figure 6, the larger Blue
force suffers heavier casualties. 

The Morse and Kimball case

In 1951, Morse and Kimball published their examinations on a spe-
cial case of the Lanchester-type equations [20]. Based on the general
form shown earlier, their special case assumes r = v = 1, s = u = 0, and
positive values for NR, NB, , and . We get the following set of dif-
ferential equations: 

Figure 6. Lanchester Logarithmic Law chart
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The equations are very similar to those of the Square Law example.
However, the additional terms allow the modeling of much more
complex battles. For example, the terms NR and NB allow a model to
include the element of replacement/reserve troops in a battle. Fur-
thermore, factors  and  can be thought of as the impact of indirect
fire by enemy forces or operational loss due to illness and non-combat
related injuries. 

Summary

As shown above, various forms of the Lanchester-type equations can
be used to model a rich set of combat scenarios, and are still widely
used in many of today’s computerized combat models. However,
Lanchester-type equations are based on many simplifying assump-
tions, which are discussed below.

Key assumptions

Lanchester equations represent highly abstract versions of combat,
which are based on many simplifying assumptions, a few of which are
shown below:

• Two homogeneous forces are engaged in a fire fight. Members
of each force have the:

— same weapon systems

— same fighting capabilities

— same vulnerabilities.

• Each unit on either side is within weapon range of all units on
the other side.

• Effects of successive rounds in the target areas are indepen-
dent.

• Both forces have constant lethalities (i.e., KB and KR are con-
stants).

• Time spent on searching for surviving enemy units is indepen-
dent of enemy force level.

• Fire is uniformly distributed over surviving enemy units.

α β
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Many of these assumptions are probably appropriate for the type of
static trench warfare in the European theater during World War I.
However, these assumptions are inadequate to address many of
today’s scenarios. For example, the assumption that a force is homo-
geneous is contrary to real-world observations of diverse individual
behaviors in a battle. Therefore, a new approach is needed to analyze
these problems.

Agent-based models offer a new approach

In contrast to Lanchester-type equations, multiagent-based models
like ISAAC and EINSTein are based on the mathematical framework
generally classified as cellular automata (CA), which can be defined as
“a class of spatially and temporally discrete, deterministic mathemat-
ical systems characterized by local interaction and an inherently par-
allel form of evolution” [21]. 

First introduced by the mathematician von Neumann in the
early 1950s to act as simple models of biological self-repro-
duction, CA are prototypical models for complex systems
and processes consisting of a large number of identical, sim-
ple, locally interacting components. The study of these sys-
tems has generated great interest over the years because of
their ability to generate a rich spectrum of very complex pat-
terns of behavior out of sets of relatively simple underlying
rules. Moreover, they appear to capture many essential fea-
tures of complex self-organizing cooperative behavior
observed in real systems.

ISAAC and EINSTein have been followed by many other cellular
automata-based combat models. Because of their origin in complex-
ity theory, EINSTein and other multiagent-based models can offer a
fundamentally different approach to study a combat scenario as what
it is, i.e., a complex adaptive system. In comparison, many conven-
tional models can only pre-program a finite number of behaviors in a
combat scenario. We explore EINSTein in more detail next.
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“EINSTein” goes to war

In this section, we first review results from recent CNA ground
combat studies using EINSTein. The studies show how EINSTein can
be used effectively to model small-unit combat scenarios.7 

Review of CNA ground combat studies

Ground Combat Studies (GCS) refers to a series of CNA-initiated
projects looking at ground combat for the USMC at the small unit
(squad and fire team) level. As part of the project, a model for the
simulation of ground combat was chosen to study the factors that
most influence the composition of squads and fire teams for the
Marine Corps as well as factors that influence outcomes of specific
combat scenarios. After evaluating a number of models, the multi-
agent-based model EINSTein was selected to simulate the ground
combat scenarios typical of what Marines face on the battlefield. 

EINSTein is an “agent-based” model where agents, which represent
individual soldiers, are programmed with “personalities,” which influ-
ence them to act or react in certain ways to a number of perceived sit-
uations. For example, the agents in many of the studies in this project
were five times more likely to advance towards enemy agents than
towards friendly agents when healthy, while injured agents tended to
move towards friendly agents and avoid enemies. 

By setting up relatively simple “rules,” which define the personalities
of the individual agents, and allowing the agents to interact with each
other over time, information about the larger scale behavior of
groups of agents can be collected and analyzed. In addition to setting

7. EINSTein is available for download from CNA’s website at http://
www.cna.org/isaac [34]. In addition to the software program, the web-
site also includes detailed user’s guide and an extensive collection of ref-
erence resources.
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the personalities of the squad members, other variables such as
weapon types and distribution, communications ability, and terrain
effects can be set up in the program, and varied across multiple sim-
ulations. Results of the battles between opposing forces can be ana-
lyzed (generally in terms of attrition curves or a probability
distribution of agents remaining at the end of a simulation), and
trends in these data can be determined as a function of changing vari-
ables or parameters over the course of a number of simulations.

It should be noted that results for scenarios or battles are given over
an average of many simulations, or runs, of the battle. Due to the sto-
chastic nature of the simulations, the scenarios may be subject to run-
to-run variability where either force may win (or more generally, one
specific outcome occurs out of many possible outcomes). Attrition
results are usually presented from an analysis of the overall averaged
results, but probability distribution functions derived from the data
can give some information about the variability of the results from
run to run. While overall trends in the data are necessarily derived
from the averages of the results, interesting insights into the dynamics
of a scenario can often be obtained from observing individual runs in
which the outcomes are highly variable.

Modeling a wide range of scenarios

One of the first goals in using EINSTein to model USMC small unit
engagements was to simulate the wide range of different combat sce-
narios that Marines may encounter on the battlefield. A study
in February 2005 [22] attempted to model seven different small unit
scenarios, including (1) patrolling in formation, (2) reconnaissance,
(3) infiltration of an enemy position, (4) security operations, (5) per-
forming an ambush or reacting to an ambush (anti-ambush), (6) call
for fire, and (7) fire and movement or bounding overwatch maneu-
ver. These scenarios were selected from information derived from the
Guidebook for Marines [23].

In this study and in subsequent studies, a “baseline” scenario was set
up for simulation where all agent personalities, squad number and
make up, enemy personality and force make up, weapon types and
distributions, sensor and communication ranges, terrain effects, etc.,
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were defined for the specific scenario. Excursions from the baseline
scenarios were then performed, and the results from the excursions
were compared to results from the baseline scenarios. Excursions
generally aimed to change a key parameter or variable thought to be
important to the outcome of a given scenario (e.g., having communi-
cations turned on or off). These seven scenarios were used as a proof-
of-principle to show that EINSTein could simulate combat simula-
tions and provide results that were “realistic” and could reproduce
conclusions and trends that coincide with the experience of Marines
based on exercises and real combat situations. From the seven scenar-
ios listed above, patrolling, reconnaissance, security, ambush/anti-
ambush, and call for fire were all simulated successfully in EINSTein.

In one of the examples, the “Call for Fire” scenario, a Blue squad was
created that was comprised of four agents and a Red squad was cre-
ated that consisted of 13 agents. The Blue agent personalities were
defined so that the agents were more likely to advance towards enemy
agents than friendly agents. However, if the Blue agents came under
fire from the Red squad, a “meta-personality” was activated in the
Blue agents and they backed away from the enemy.8 Once the agents
backed away from the enemy, they were able to communicate with a
defined “super-agent,” which represented a strike plane that would
provide tactical air support. The agent representing the plane was
able to move towards the enemy at a rate four times what the normal
agents could move, and possessed a high power area weapon repre-
senting a 2,000-lb Joint Direct Attack Munition (JDAM) bomb. The
plane was also defined as being invulnerable to attack by the enemy
(although the authors point out that they could simulate the plane's
vulnerability to enemy air defenses by reducing the armor rating of
the plane). Thus, when the Blue squad made contact with the Red
squad, the Blue agents called in an air strike and the plane moved to
attack the Red agents. The Blue agents, then, were able to advance to
attack and finish off the injured Red agents. In this scenario, an agent
was used to represent a vehicle in the simulation (although, the
authors admit, in a crude way), which shows the ability of users to

8. For more description of assigning personality traits and meta-personal-
ities, see the following section titled “Basic Setup for Using EINSTein”.
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adapt EINSTein to the specific details of the scenario they want to sim-
ulate. Indeed, the wide variety of scenarios modeled in these seven
scenarios demonstrate the versatility of the model. 

Even though EINSTein showed the ability to model a number of dif-
ferent scenarios for small unit combat, there were scenarios
that EINSTein was unable to realistically model in this study. Both the
enemy infiltration scenario and the fire and movement scenario were
unable to simulate the behaviors of fire teams executing the given
tasks. The most likely reason that these scenarios could not be mod-
eled was that the basic personalities and parameters assigned to the
agents in the squads in this study did not produce more complex
coordination and problem-solving behaviors needed to perform
these two scenarios. For example, in the fire and movement scenario,
the Blue squad was split into two teams against a single Red squad.
One Blue team is supposed to engage and fire at the Red squad while
the second Blue team loops around the Red squad and attacks their
flank. However, during the simulation, the teams did not act in a way
consistent with how real teams would act. This is because,
in EINSTein, the concept of fire suppression is not easily modeled,
and the Red squad under attack does not “hunker down” when fired
upon. Furthermore, the rules used in these scenarios have the agents
shoot at the enemy whenever they can see the enemy and whenever
the enemy is in weapons range. The fire and movement and the
enemy infiltration scenarios require the “restraint” of the units to not
fire at enemies when they see them, but to perform movement to
either avoid enemies (for infiltration) or to get into better position
first before firing at the enemy (for fire and movement). More com-
plicated personality profiles could probably be created to allow the
successful modeling of these scenarios, but this was beyond the scope
of the study.

Defensive combat modeled in EINSTein

CNA analysts tried to model defensive combat scenarios using the ter-
rain feature in EINSTein. Defensive forces were set up behind terrain
features while attacking forces attempted to overrun the position to
capture the defender's flag. 
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A simple example of this scenario had a force stationed behind a
simple berm, which reduced their visibility to attackers [24]. When
both forces were the same size and possessed the same weapons, the
defenders generally lost fewer troops than the attackers and were
defeated in only a small number of the runs. By varying the number
of attacking agents, the model demonstrated that an attacker-to-
defender ratio of approximately 3:1 was needed for the attackers to
routinely overrun and defeat the defenders. This result is in agree-
ment with the general rule of thumb9 for attacking forces from real
life combat experience, and showed the ability of EINSTein to model
this scenario realistically and derive the same conclusions as experi-
enced Marines. 

This result led to recommendations by Headquarters Marine Corps,
Programs & Resources division for further study of a defensive
combat scenario, in which a Blue force defends terrain in a rocky
environment against an attacking enemy Red force [27]. The base-
line scenario defined a larger attacking Red force that included
squads of 60 troops with “standard weapons” (rifles, grenade launch-
ers, etc.) and 60 irregular troops with rifles and rocket propelled gre-
nades (the irregular troops also had a “tremor factor” that reduced
the accuracy of their weapons). The attacking force had tanks (125-
mm cannon) and infantry vehicles (30-mm cannon). The Blue force
consisted of 45 troops in the defense that possessed four anti-tank
missiles (TOWs10 and Javelins) as well as two .50 caliber machine
guns. The rocky terrain around the Blue force reduced their visibility
to the attackers by roughly 60 percent. Excursions from the baseline
scenario included varying the weapon types and number, varying the
number of attackers, and varying the “intelligence” of the defenders
(with emphasis on how and when weapons were used).

In the baseline scenario, the attackers overran the defenders 70 per-
cent of the time. However, by observing results from individual runs,

9. Origin of the “3:1” rule in ground combat is not clear [25]. Some have
attributed it to a letter from President Lincoln to Union Army Major
General Halleck during the Civil War [26]. 

10. TOW stands for Tube-launched, Optically tracked, Wire-guided.
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the authors of this study noted that the defenders were able to hold
off the attackers when the small number of Blue agents with the .50
caliber machine guns avoided being killed early in the battle (a sto-
chastic event). Thus, the excursion scenarios were designed to exam-
ine the effect of adding more machine guns as well as changing the
personalities of the Blue agents to defend the machine gun wielding
agents at the beginning of the battle until the tanks and infantry vehi-
cles could be neutralized.

The results of these excursion scenarios demonstrated the impor-
tance of protecting high value assets, that proper targeting of ene-
mies is important, and that proper training and tactics are more
important to overall success than simply adding more firepower.
Much like the earlier defensive scenario, these results coincide with
the expectations and experiences of Marines in real life combat sce-
narios.

Combat in open terrain and urban warfare

Based on the demonstrated abilities of EINSTein to simulate the wide
range of scenarios discussed above, the Commandant of the Marine
Corps requested that the GCS model ground combat in an open envi-
ronment and in an urban setting [28]. In the baseline scenario for
the open terrain environment, the Blue and Red forces were of equal
size and had similar personalities and weapons. The Blue force was
designed with 60 agents broken up into 5 squads, while the Red force
consisted of 60 agents arranged either as one large group, 5 squads of
12 agents, or fully dispersed throughout the battlefield. For each
force, weapons consisted of rifles, machine guns, and grenade
launchers (distributed in a 2:1:1 ratio, respectively). The Blue squads
had the ability to communicate with each other, while the Red troops
had no communications capability. 

The main objective was to study the effects of initial enemy dispersion
on the performance of the Blue squads in the battles. Excursions
from the baseline scenario included changes in weapon types, sensor
range, visibility, and communications ability. For the simple rules
describing the agent personalities in these simulations, it was appar-
ent that anything facilitating location of the opposing force led to
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more combat and higher attrition rates, while limiting the ability to
find the opposing forces led to less combat and lower attrition. For
example, dispersing Red agents homogeneously over the battlefield
led to more Red attrition than dividing the Red into five squads
because it was easier for the Blue squads to find the Red agents when
they were completely dispersed. Other excursions demonstrated the
benefit of technology, where agents with “night vision” could easily
dominate an enemy without this technology. In these scenarios,
sensor ranges were very short for Red agents (simulating their limited
ability to see in the dark) while Blue agents had much larger sensor
ranges simulating the use of night vision equipment. Visibility and
weapons capability were determined to be important factors in the
results of these scenarios. 

An interesting and counter-intuitive result from these simulations was
that communications ability for the Blue agents actually led to higher
Blue attrition than not having any communications. It is generally
expected that forces will do better with the ability to communicate
with each other, but, in this case, communications only made it easier
for Blue squads to locate the Red agents and engage in combat, and
communications weren't used to coordinate action between the dif-
ferent squads, where the benefit of communications lies. Such coor-
dinated action is an example of a higher order behavior that is not
observed with the simple rules programmed into the agents in these
scenarios.

Following on the results of combat in open terrain, the study next
looked at the effects of five Blue squads against differently distributed
Red forces in an urban environment. In these scenarios, buildings
were simulated as obstacles arrayed regularly in a grid, through which
agents could neither move nor see through. The buildings were set
up with a 5-by-5 size with 2 battlefield units separating each building.
Given the size ratios of building size to battlefield size, these buildings
would be more accurately described as city blocks and not individual
buildings, although the authors were not convinced that finer resolu-
tion was needed to capture the essential trends in the data. For these
simulations, the baseline scenario was the same as described for the
open terrain scenario (except for the inclusion of the buildings).
Excursions from the baseline included varying street size, building
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size, communications ability, visibility (fighting at night), weapons
capability, and using patrols of Blue agents around the battle space.
The results of these simulations were similar to the open terrain sce-
narios in that combat and attrition rates are ultimately determined by
the ability of the forces to find each other. Overall, compared to the
open terrain scenario, there was much less combat and attrition
because the buildings limited the sensor and weapon ranges, and
made it harder to find and fire upon opposing forces. These results
and observations agree with the conclusions from the Hunter Warrior
and Urban Warrior experiments conducted by the Marine Corps
Warfighting Lab (MCWL) [28]. 

Although the conclusions reached by the urban warfare simulations
agreed with similar conclusions from MCWL, there were some
aspects of the model which could not capture real soldier behaviors.
One problem had to do with the agents having no “memory.” For
example, if a Blue agent was chasing a Red agent, the Blue agent
would stop his chase if the Red agent went around a building corner
and out of the Blue agent's sensor range. Also, if a Blue agent was
killed going around a corner by a Red agent, other Blue agents in the
same area would continue going around the corner instead of react-
ing to the sight of another agent being killed just a few moments ear-
lier.

Discussion of the use of EINSTein for the GCS

Overall, the EINSTein simulations were able to recreate important
trends in ground combat and identify important factors affecting the
outcomes of certain battle scenarios. The determination of the 3:1
attacker to defender ratio needed to take a defensive position, the
identification of important tactics such as protecting high value
assets, and the conclusion that a drop in weapon and sensor range
will greatly affect urban combat are important proofs that
the EINSTein model can simulate important aspects of real world
combat. 

Thus far, the goal of the GCS has been recreating known trends. A
more far reaching goal would be to use EINSTein to predict trends or
reach novel conclusions from combat scenarios where little, if any,
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empirical data exist. However, one must be careful when trying to
produce trends without external empirical support. This is ultimately
very difficult because it requires the user of the model to be able to
differentiate between a real trend and something that is an artifact of
the model (and hence, not a trend in the real world). For example,
the required 3:1 ratio of attackers to defenders is an EINSTein-world
result which maps onto the real world as well. However, the use of
communications actually hindering a force as opposed to having no
communications is an EINSTein-world result that is known not to be
true in the real world for reasons discussed above. A key step in con-
firming that this model can be used more predictively will be the abil-
ity to model more complex behavior within and between the agents,
and thus making the EINSTein world more similar to the real world.
However, the problem of deciding the “truthfulness” of a prediction
from EINSTein will still be a fundamental problem.

A related issue seems to be the extent to which the agents can be
thought of as “people” and the extent to which the user needs to
remember that the agents are just “robots” that are programmed to
react in a certain way to certain stimuli, keeping in mind that these
stimuli are stochastic in nature. The simple defining of the personal-
ities of agents can make them rush toward an enemy or retreat from
an enemy, but the rules in EINSTein needed to produce more com-
plex behavior such as coordinated movement between squads to
attack an entrenched enemy may be unknown and difficult to discern
with the current methodology of setting a base scenario and taking
relatively minor excursions from the scenario by changing a few key
variables (although a skilled user of EINSTein may be able to produce
these behaviors with intelligent choices for the personality and trig-
ger state definitions).11

Interestingly, there is a component to EINSTein that allows a user to
iteratively optimize a force to achieve a well-defined goal or mission.
The genetic algorithm (GA), in principle, allows a user to define a
goal or set of goals (such as maximize Red casualties, or minimize
Blue casualties, etc.) and let the algorithm search a given parameter

11. The next version of EINSTein is designed with a new command and
control module to allow modeling of more complex scenarios. 
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space to develop the characteristics of the squad or squads that are
“optimal” in achieving the goal or mission. For example, in trying to
create an infiltration scenario, the goal would be to create a squad or
squads that can minimize the time required to get to a point (x,y) on
the battle space while also minimizing the number of Blue casualties.
The algorithm would then “synthesize” or “breed” a squad or squads
that could best achieve these goals (i.e., these squads have certain
values or ranges of values defining their personalities that allow them
to perform some stated goal or goals with a level of proficiency). Rel-
evant questions to ask once an optimal force is created for these sim-
ulations may include:

• How do the squads achieve their mission?

• What are the personality profiles of the squad members and
how would one qualitatively describe them?

• How sensitive are the results to small changes in some of the
perceived key variables in the model?

Of course, there may be many limitations to this approach (not even
considering computer time needed and the ability to accurately
define a set of goals or missions for the algorithm to work towards).
It may be very difficult to interpret the results of such an optimiza-
tion. If the combination of parameters and personality traits for the
optimized force is sufficiently complex as to be not understandable by
a simple qualitative (or quantitative) analysis, can the computational
and analysis time be justified? Additionally, if “sensitivity analyses”
should be run on a number or variables, how can one identify what
variables should be “key variables”? How can one reconcile a sensitive
variable that does not make logical sense to an analyst or a variable
that can be altered in EINSTein, but does not have an easily identifi-
able real world analogue (for example, if soldiers only with a certain
value or set of values for “advancing towards enemy” can complete a
given mission)? These results may not produce meaningful conclu-
sions for the analyst and, most importantly, for the USMC.

Updates to the program over time may help in improving the realistic
nature of the simulations. In addition, they may make it easier and
perhaps simpler to implement some of the earlier combat scenarios.
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Changes in the program as described recently [31] include a memory
function for the agents, a greater range of health states, a dynamic tar-
geting logic for the agents, and a more dynamic refinement of meta-
states (trigger states) that could result in more complex behavior and
actions for an individual agent or groups of agents. For example, in
the most recent article about EINSTein from Andrew Ilachinski, an
example of a trigger state called “Hunkered Down” is given where
presumably these agents would take up defensive positions when
under enemy fire. This type of behavior was not easily induced in pre-
vious versions of EINSTein and led to some troubles in modeling cer-
tain combat scenarios. A variety of other trigger states may be defined
that can model “real” behaviors of soldiers and squads on a battle-
field. Furthermore, the addition of command and control features in
future updates will significantly enhance the ability of the user to
model more “realistic” combat scenarios.

Comments on VV&A

As shown earlier, models play important roles in many areas of the
DoD community. In order for models to be trustworthy, DoD requires
that they go through a verification, validation and accreditation
(VV&A) process [35, 36, 37]. Definitions of these terms are shown
below. 

“Verification is the process of determining that an M&S
accurately represents the developer’s conceptual descrip-
tion and specifications. Verification evaluates the extent to
which the M&S have been developed using sound and estab-
lished software-engineering techniques.

Validation is the process of determining the extent to that
an M&S is an accurate representation of the real world from
the perspective of the intended use of the M&S. Validation
methods include expert consensus, comparison with histor-
ical results, comparison with test data, peer review, and inde-
pendent review.

Accreditation is the official determination that a model, sim-
ulation, or federation of M&S is acceptable for use for a spe-
cific purpose” [37].
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As the definitions suggest, the VV&A process is to be implemented
throughout the developmental steps of a model which is shown in
figure 7. As shown in the figure, the end-user needs should always
drive the modeling processing. 

The most challenging part of the VV&A process is probably the
middle “V”, validation. However, as Ilachinski pointed out [31], since
EINSTein is designed as “an exploratory model, validation is less of an
issue than it might be for more ostensibly realistic models. As long as
EINSTein’s outcomes are intuitive and its inputs are easy to general-
ize (or translate) for use by more realistic models, EINSTein will
remain useful for many different kinds of exploratory analyses.”

Summary

Overall, EINSTein has shown its efficacy and versatility as a model for
ground combat by small units. A wide range of different small unit
engagement scenarios has been simulated in EINSTein and impor-
tant trends can be discerned that correlate well with empirical data
from exercises and historical accounts of battles. For example, the 3:1
attacker to defender rule of thumb, the importance of better tactics

Figure 7. Modeling steps and VV&A
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over better firepower, and the conclusions about limitations in urban
combat are important results and show EINSTein can accurately
model certain aspects of ground combat. 

Although EINSTein, as with any model, can only approximate a real
battlefield, information that has some mapping onto real combat sit-
uations can be easily extracted by analysts. EINSTein is much more
than a quick visualization tool, the program is designed as a capable
data collection tool. Our review of the recent CNA studies and the
tutorial in the next section show only a few of the rich features avail-
able in EINSTein.12 Some of the key features that we did not get a
chance to explore include “intelligent route-finding, scriptable way-
points, and programmer access to all of EINSTein’s 300+ source code
level functions using EINSTein’s recent port to the Python scripting
language13”[29]. 

Basic setup for using EINSTein

In this section, we will discuss the basic setup of a battle, or run, in
EINSTein, show how to assign “personalities” to agents, and highlight
some interesting sample scenarios to demonstrate the diversity of the
model for company/battalion-scale engagements involving many
agents. For a much more complete discussion of EINSTein and how
to use the program, see the publications from Andrew Ilachinski [31,
32, 33]. 

12. Our limited scope also did not permit us to review EINSTein’s applica-
tions outside of ground combat. In fact, EINSTein and other agent-
based models have shown wide applicabilities covering a variety of mili-
tary and non-military problems. For example, CNA has led “a series of
workshops at the Naval Postgraduate School applying EINSTein to a
maritime environment” (e.g., swarm attack tactics by small boats on a
high value unit) [29, 30]. 

13. For example, EINSTein’s Python extension allows a batch of multiple
simulations to be run simultaneously on a single computer. This dramat-
ically increasing its data collection capability [29].
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Setting up the battlefield and forces

The battlefield size in EINSTein can be set using the Edit > Battlefield
Dimensions tab in the toolbar menu. The dimensions of the bat-
tlespace can be entered in the appropriate fields for the length and
width (these distances are given in arbitrary units). Locations on the
battlefield such as the flag and goal positions are designated with an
x-y coordinate within the battlespace. 

The user can create a single or multiple squads of agents for either of
the two sides (Red or Blue) under the Edit > Force Parameters tab in the
toolbar menu. The user can specify both the number of squads and
the number of agents assigned to each squad. Additional force-wide
parameters can be assigned under the Edit > Force-wide Parameters tab
in the toolbar menu. Here, the coordinates for the flag of each force
can be assigned and other parameters such as the logic for moving
around terrain elements and the communications ability can be
assigned. The terrain movement logic describes the way agents move
through the battlespace when terrain elements are introduced, and
the communications ability allows agents to communicate informa-
tion to other agents over distances longer than their normal sensor
ranges. The examples in this section do not enable the terrain move-
ment options or communications features, but other CNA publica-
tions in the GCS discuss the use of these features within combat
scenarios [22, 24, 27, 28]. 

Assigning squad personalities

The initial battlefield and force parameter assignments described
above create the two forces and the basic battle area for these forces.
At this point, starting the simulation will result in the agents randomly
moving around within a small area near the starting point (this is
actually the default scenario that loads when opening EINSTein for
the first time). In order to get the agents and forces to do something
“interesting,” personalities must be assigned to the agents.

Agent personalities are developed through “weighting factors” for
certain actions an agent can take on a given time step during the sim-
ulation. The action chosen by an agent is based on a “local penalty
function,” which the agent uses with the weighting factors to deter-
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mine the “best” action to take during a given time step. A much more
thorough discussion of the general decision logic of the agents is
given in another document [33]. Basically, the relative weights given
to possible actions influence the agents to move in a certain direction
or to fire at a certain target. For example, a couple of basic personality
traits are the “desire” to move towards an enemy agent or to move
towards a friendly agent. Depending on the relative values assigned to
these two traits, the agent may chose to move to a location on the field
closer or farther away from enemy agents (or friendly agents). There
exist a number of parameters in an agent's personality that can be
assigned weighted values, but for the purposes of this report, we will
only describe a few basic parameters needed to get an unfamiliar user
started using the program. 

Under the Edit > Agent Behaviors > Spatial Orientation/Movement tab on
the toolbar menu, a table listing the parameters for the agent person-
ality weights and the spatial distribution parameters for the squads is
displayed (see figure 8).

The flag position can be set in this window (as well as in the Force-
wide parameters window), and the coordinates for the goal of each
squad can also be set. Notice the goals do not have to be the same
locations as the opposing flags. The initial location and distribution
of both forces can be assigned as well, and the forces can be initially
positioned either near the flag/goal or away from these locations.
The forces can be either narrowly or widely distributed at the begin-
ning of the simulation.
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The middle portion of the window in figure 8 displays the “traits” for
the agents' personalities with input windows for the trait weighting
factors. Notice that the agents in different squads can have different
personalities, but, currently, all members of the same squad must
have the same user-defined personality. There are12 personality traits
listed in this window, but in the sample scenarios presented in this
document, we will only assign values to 6 of these traits (with the other
traits having weights of zero). There are 2 basic “states” which
describe the health of the agent over the course of the simulation.
Agents are either designated as “alive” or “injured” and the personal-

Figure 8. Agent behavior parameters window
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ity traits can be assigned specifically for the different health states. An
agent can also be dead, of course, and these agents disappear from
the battlefield. The personality parameters used in the examples
given below are:

• Alive ally: weight for agent to move towards an alive friendly
agent

• Alive foe: weight for an agent to move towards an alive enemy
agent

• Injured ally: weight for an agent to move towards an injured
friendly agent

• Injured foe: weight for an agent to move towards an injured
enemy agent

• Own flag: weight for an agent to move towards own force's flag

• Goal: weight for an agent to move towards the force's goal.

In addition to the parameters listed above, the agents can also be
assigned “meta-personality” parameters. An agent meta-personality is
an adjustment to the default personality based on the specific circum-
stances an agent perceives in the local environment. The user can
specify some threshold constraints that have to be satisfied prior to
the activation of the meta-personality. For example, for the combat
meta-personality, an agent will assess the difference in the number of
friendly agents and enemy agents in a given range (which can also be
assigned) and attack the enemy if the difference is greater than the
number assigned for this parameter. This number can be positive or
negative so that agents may only attack an enemy with numerical
superiority (positive threshold) or they will attack the enemy even if
they are outnumbered (negative threshold). The meta-personality
parameters used in the sample scenarios are:

• Advance: An agent will advance toward the goal if a minimum
number of friendly agents is near.

• Cluster: An agent will stop moving towards friendly agents if the
number of friendly agents exceeds a given threshold.
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• Combat: An agent will move towards an enemy if the difference
between friendly agents in the area and enemy agents in the
area exceeds a given threshold.

Further discussion of these and other personality parameters and
meta-personalities is given in another report [33]. 

Weapon arsenals and assignments

Up to ten different weapon types, five of which are predefined, can
be used by agents in an EINSTein model. The weapon arsenal window
can be seen by selecting the Edit > Weapon Arsenals tab in the toolbar
menu (see figure 9).

As shown in figure 9, weapons in EINSTein are characterized by the
range (in battlefield units), firing rate (rounds per time step), ammo
capacity, power, blast radius (for area weapons), armor (amount of
protection they provide), deviation or inaccuracy, and the reliability.
Any of the values can be changed for the previously defined weapons,
and new weapon types can be created by changing the values (and the
name) for any of the Default weapons shown in the bottom five rows
in figure 9. For example, in some of the scenarios described below, we
define a “shock weapon” that has short range of one unit and power
of 0.05 to enable close range combat. 

Figure 9. The default weapons arsenal in EINSTein
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The user can assign these weapons in any distribution to the agents in
a squad by choosing the Edit > Weapon Assignments tab in the toolbar
menu. An agent can be assigned at most one weapon so that the total
weapons assigned cannot be more than the total number of agents in
a squad, although the user may assign fewer weapons than squad
members. The assigned weapons are distributed randomly to the
agents in the squad.

Movement and sensor ranges

The final parameters used to set up the sample scenarios for this sec-
tion are the movement and sensor ranges. These ranges can be
assigned by choosing the Edit > Agent Capabilities tab in the toolbar
menu. Movement range is the number of battlefield units an agent
can move in a time step, while the sensor range is the number of bat-
tlefield units an agent can “see” prior to making a decision to move
in a direction or to fire on an enemy. These ranges can greatly affect
the dynamics of the simulations as discussed below. Other parameters
in the window are not used in this report, but are discussed in more
detail elsewhere [31, 32, 33].

Terrain elements

Terrain elements, which restrict movement and line of sight (LOS),
can be introduced into the battlefield environment. Terrain can be
drawn onto the battlefield by clicking the right mouse button and
selecting “Draw Terrain” from the menu. A number of options come
up with different movement and LOS restrictions. More information
about these terrain types can be found under the Edit > Terrain Types
tab in the toolbar menu. The numerical values for “passability” and
visibility are given for the default terrain types, and these values are
the fraction by which the movement and sensor ranges are reduced
for agents near the terrain element. User-defined terrain elements
can also be created in this window by selecting the “New” tab and
inputting the values for passability and visibility and naming the ter-
rain element.
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Examples of battle simulations using EINSTein

For the sample scenarios presented in this section, we demonstrate
company/battalion-scale troop behavior similar to the original
intended use of EINSTein (and ISAAC) for exploring emergent
behavior in complex systems [33]. This is different than the previous
use of EINSTein for the GCS, which studied small unit combat at the
squad and fire team level. 

In the following scenarios, we use a single squad consisting of 300
agents for both forces, and show that the assignment of simple per-
sonality values can result in the observation of complex behaviors of
groups of agents. Furthermore, varying a small number of these
parameters can lead to different overall behaviors of the forces, which
demonstrates the diversity and flexibility of EINSTein.

Example 1: Linear battle fronts

The first example we discuss is similar to a case study in an earlier
CNA publication [33]. The key agent parameters for this example are
listed in table 1. 

Table 1. Example 1: agent parameters

Agent parameter Alive
(Healthy) Injured

Alive ally 10 10
Alive Foe 50 50

Injured Ally 10 10
Injured Foe 50 50
Own Flag 0 0

Goal 1 1
Advance 2 3
Cluster 4 6
Combat 3 6

Movement range 1 1
Sensor range 10 10

Weapon range 7 7
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The Red and Blue forces are given identical personality weights and
weapon assignments (the weapon range listed in table 1 is just the
range for the default bolt action rifle). Both forces were situated at
their own flag at the beginning of the run (Red in the bottom left cor-
ner, or (0, 0) on the battlefield grid and Blue in the upper right cor-
ner, or (99, 99) on the grid). 

At the beginning of the run, the forces advance towards the center of
the battlefield as they make their way to their respective goals (the
opposing force's flag). As the forces move within sensor range of each
other, they form two lines stretching across the battlefield and begin
firing at each other. Figure 10 shows the configuration of the two
forces approximately 130 time steps from the beginning of the run.

At this point in the simulation, both forces have lost ~ one-third of
their forces. As the simulation continues, both sides take losses until
the battle breaks and both forces rush to the opposite flag. The sto-
chastic nature of the model precludes one from predicting which side
will lose more troops during a single run in this scenario. However, by
running a number of simulations and analyzing the average results,
conclusions can be made about the average performance of each
force. 

Figure 10. Example 1: screenshot
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Results for these runs are usually presented in terms of attrition over
time, but a number of different measures can be used to evaluate a
particular scenario. The different types of data that can be collected
can be found by selecting the Data Collection tab on the toolbar menu.
These data types are further described in other publications discuss-
ing EINSTein [31, 32, 33]. 

To collect data over multiple runs, the Simulation > Run Mode > Multi-
ple Time Series tab on the toolbar menu can be selected. The user
enters the number of runs and the number of time steps for each run.
EINSTein then runs the simulations (without the graphical display of
agents) once the user begins the simulation (from the Simulation >
Run/Stop tab on the toolbar menu).

Once the simulations are complete, the data for attrition, for exam-
ple, can be visualized graphically by selecting the Data Visualization >
2-D graphs > Attrition tab on the toolbar menu. Figure 11 shows attri-
tion data averaged over 20 runs of this scenario.14 Data can also be
saved and exported into spreadsheet programs like Excel for further
analysis.

As shown in figure 11, attrition profiles of both forces are very similar.
This should come as no surprise since their agent parameters are the
same. 

14. Each simulation lasts for 200 time steps.

Figure 11. Example 1: Average attrition dataa

a. For 20 runs of the linear battle front example.
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Example 2: Dispersive battle

In the previous example, when the opposing forces approached each
other, they stopped their movement toward the opposing flag and
engaged each other in battle by forming firing lines in the configura-
tions shown in figure 10. In that example, the agents' sensor and
weapon ranges were much longer than the movement range. In this
section, we present a second sample scenario where the sensor range
and movement range are equal (values set to 5), while the other agent
parameters are set to the same values as in the previous example (see
table 1).

As the run begins, the forces move toward the opposing flags and
approach each other as they did in the previous example. However,
instead of stopping and forming firing lines, the forces run headlong
into each other and a small degree of “mixing” or interpenetration of
Red and Blue agents occurs where the two forces engage each other
as shown in the left panel in figure 12. As the battle evolves, the agents
in the two forces disperse into a random configuration of smaller fire-
fights all over the battlefield as shown in the right panel of figure 12.

Figure 12. Example 2: screenshotsa

a. The screenshot on the left shows the initial engagement of the two forces (t=10), while 
the screenshot on the right shows the agent configuration just nine time steps later 
(t=19).
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Interestingly, the much different collective behaviors of the agents in
the linear battle front example and in this dispersive battle example
arise from a change in just two of the parameters (movement and
sensor range) of the simulation. In fact, varying the ratio of sensor
range to movement range causes a change in the collective agent
behaviors from the short time scale, short distance order demon-
strated in the dispersive battle example to a longer time scale and
longer range spatial order as demonstrated in the linear battle lines
example. The time scale and the length scale of the battles also are a
function of the “killing rate” or loss of agents by attrition. Thus, much
longer time scales and longer range order in the forces can be
explored by reducing weapons range and power.

Example 3: Swarming Blue forces

In this next sample scenario, the forces were made more “aggressive”
by changing the combat meta-personality thresholds. The combat
threshold for the forces is set to -99 and -3 for healthy and injured
agents, respectively, so that agents will attack enemies even when out-
numbered. Table 2 shows other agent parameters for this example. 

Table 2. Example 3: agent parameters

Agent parameters
Red Blue

Alive
(Healthy) Injured Alive

(Healthy) Injured

Alive ally 10 10 10 10
Alive Foe 40 40 40 40

Injured Ally 10 10 10 10
Injured Foe 40 40 40 40
Own Flag 0 0 0 0

Goal 10 10 0 0
Advance 3 3 3 3
Cluster 8 3 8 3
Combat -99 -3 -99 -3

Movement range 9 9 9 9
Sensor range 3 3 3 3

Weapon range 3 (50%)
1 (50%)

3 (50%)
1 (50%)

3 (50%)
1 (50%)

3 (50%)
1 (50%)
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Notice that the Red force will advance to the Blue force's flag but the
Blue force will “lie in wait” for the Red force since the Blue goal
parameter is set to zero. In addition, half of the agents in each force
were assigned user-designated “shock” weapons with a range of 1 and
half of the agents in each force were assigned the bolt action rifle with
the range reduced to 3. Screenshots of this example are shown in
figure 13.

Once the simulation is started, the Red force advances toward the
Blue flag. As the Red force moves into the sensor range of the Blue
agents, the Blue force attacks by engaging the Red force head on
while, simultaneously, some of the other Blue agents move around
the Red flanks and eventually attack the Red force from the rear as
well. The left panel of figure 13 shows the initial Blue attack including
the agents moving around the Red flanks. A short time later in the
simulation, the Blue forces have the Red force completely sur-
rounded and are able to move in and destroy the Red force.

Figure 13. Example 3: screenshotsa

a. The Red force in this example attacks the Blue flag. The Blue force first moves around the Red flanks as shown in 
the left panel and then envelops the Red force as seen in the right panel. The Blue force then moves in and 
destroys the Red force.
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Looking at the attrition data for 20 runs of this scenario in figure 14,
one can see that the Blue force dominates the Red force during this
scenario (although the Blue force does incur significant losses). 

Additionally, the Red force never makes it to the Blue flag after the
initial approach, which can be seen by plotting the distance of Center
of Mass (COM) of the Red forces from the Blue flag versus time as
shown in figure 15.

Figure 14. Example 3: attrition data

Figure 15. Example 3: CoMa distance from Blue flag

a. CoM stands for center of mass.
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Example 4: Red feint retreat

The scenario depicted in example 3 resulted in the Blue force suc-
cessfully repulsing the Red force attack on their flag. In the following
example, we show how a slight change in the Red force's parameters
results in a change of tactics by the force. In this example, the Red
force will be made less aggressive by setting their combat meta-per-
sonality threshold to 20 and 5 for healthy and injured agents, respec-
tively. For this example, the sensor range for both forces is set to 15
battlefield units and all other parameters are the same as in the pre-
vious example (see table 2). The evolution of this battle is shown in
figure 16. 

Figure 16. Example 4: screenshots time seriesa

a. Evolution of example scenario 4 as the Red force makes contact with the Blue force (t 
= 35) and appears to retreat as a smaller Blue force pursues (t = 58). The Red force 
maneuvers around the small Blue detachment and re-aggregates before the final 
attack on the Blue flag (t = 106). Now that the defending Blue force is smaller, the Red 
force takes the flag (t = 392). 

t=35 t=58

t=106 t=392
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As the scenario begins, the Red force moves towards the Blue force's
flag similar to the Red force in the previous example. However, in this
scenario the Red force halts before rushing into battle with the Blue
force (t = 35, figure 16). At this point, the Red force appears to retreat
back towards the Red flag, and a portion of the Blue force pursues the
retreating Red force. However, as the Red force is moving back, Red
agents begin to move around the flanks of the smaller Blue detach-
ment (t = 58, figure 16). The Red force then outmaneuvers the
smaller Blue attacking force by dividing into roughly two separate
forces, moving around the Blue detachment and reforming in the
middle of the battlefield for the attack on the Blue flag (t = 106, figure
16). The subsequent attack on the now smaller defending Blue force
is successful as the Red force occupies the Blue flag (t = 392, figure
16). Figures 17 and 18 show the average attrition and average center
of mass positions, respectively, over the course of 20 runs. 

Figure 17. Example 4: attrition data

Figure 18. Example 4: center of mass data
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Notice that, compared to figures 14 and 15, the Red force is able to
avoid heavy losses during the battle and the Red agents are able to get
closer to the Blue flag. In figure 18, the complex Red movements of
advance, retreat, and advance during the course of the scenario can
be observed. The previous two examples again demonstrate that
small changes in only a few parameters can lead to very different
behaviors for the groups of agents, and highlight how complex behav-
ior can arise in this agent based combat model by using just a few
simple rules defining the personalities of the agents.

Adding terrain elements

The dynamics of the simulations can be changed further by adding
terrain elements as described earlier. For example, the user could
add impassible barriers either randomly or at key areas in a battlefield
to see how this affects the overall combat. Figure 19 shows examples
of this. 

Figure 19. Screenshots of terrain elementsa

a. Adding terrain to the battle space can alter the dynamics of the battlefield. On the left, the Blue force is defending 
their flag against the Red force in rocky or mountainous terrain, reducing overall mobility. On the right, a choke 
point in the battlefield reduces the Blue force’s ability to move back into the battlefield once the Red maneuvers 
around them.
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For example, in the left pane, the Blue defenders from example 3 are
defending a flag in a rocky or mountainous territory which affect the
two force's ability to maneuver. The right pane in figure 19 shows the
Red force using a 'choke point' to reduce the pursuing Blue force's
maneuverability and increase the success of the Red force in moving
into position between the divided Blue force to take the Blue flag.
Further examples of the effects of terrain on scenarios can be found
in other CNA Ground Combat Studies [22, 24, 27, 28].

Examples of other CA-based models

ISAAC and EINSTein have inspired many other cellular automata-
based combat models. Reference [2] has a detailed account of these
models. We include the excerpts for two of the models here. 

CROCADILE (Conceptual Research Oriented Combat Agent Distil-
lation Implemented in the Littoral Environment), developed by the
Australian Defence Force Academy, is an “open, extensible agent-
based distillation engine.” In contrast to EINSTein, it “incorporates a
more realistic—albeit more complicated—projectile physics repre-
sentation of its weapons. Munitions may be fired with specified speed
and heading and a 3D collision detection algorithm is employed to
detect when agents are hit or where explosions occur” [2].

MANA (Map Aware Non-uniform Automata) is an agent-based model
developed by New Zealand’s Defense Technology Agency. It is largely
based on the design of ISAAC/EINSTein. It has built-in agents to
model non-combatants. In addition, it “exhibits many interesting and
unique characteristics, including the ability to provide agents with
memory maps of the locations of previously sensed enemies” [2].
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Conclusions

This primer provides an elementary introduction to ground combat
models in general, and EINSTein in particular. Ground combat
models have evolved over the past four thousand years from ancient
board games to modern-day computerized simulations. However, the
essence of a model has not changed. Models are abstractions of the
real world that allow us to study and better understand the real world. 

Current DoD combat models are predominantly deterministic in
design and often incorrectly use the Lanchester-type equations to cal-
culate force-on-force attritions. We show that the Lanchester equa-
tions can model fairly complex battle dynamics (e.g., ambush in the
Logarithmic Law example, and use of reserves and operational loss in
the Morse and Kimball case). However, they include too many simpli-
fying assumptions to remain valid in many of today’s combat prob-
lems. Multiagent-based models, based on the mathematics of cellular
automata, offer a novel approach to combat problems that analysts
should not ignore. 

The CNA Ground Combat Studies have shown successful applications
of EINSTein including the 3:1 attacker to defender ratio, patrolling
in formation, reconnaissance, security operations, ambush, and call
for fire. EINSTein is constantly being updated, and new features are
added. Our review of CNA ground combat studies and the brief tuto-
rial of the software toolkit show only a small fraction of the rich fea-
tures that are already available in EINSTein. 

One of our objectives is to encourage interested readers to try out
EINSTein. To facilitate this, we have provided several sample scenar-
ios to show the various features of EINSTein.
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Glossary

ABM Agent-based model
CA Cellular automata
CASTFOREM Combined Arms and Support Task Force Evalua-

tion Model
CGF Computer Generated Forces 
CIM CNA information memorandum
COM Center of mass
CROCADILE Conceptual Research Oriented Combat Agent Dis-

tillation Implemented in the Littoral Environment
DMSO Defense Modeling and Simulation Office
DoD Department of Defense
EINSTein Enhanced ISAAC Neural Simulation Toolkit

EMS Essentials of Modeling and Simulation
GA Genetic algorithm
GCS Ground Combat Studies
GCAM General Campaign Analysis Model
IED Improvised Explosive Device
ISAAC Irreducible Semi-Autonomous Adaptive Combat
ITEM Integrated Theater Engagement Model
JCATS Joint Conflict and Tactical Simulation 
JDAM Joint Direct Attack Munition
JFCOM Joint Forces Command
JICM Joint Integrated Contingency Model
JMEM Joint Munitions Effectiveness Manual 
JSIMS Joint Simulation System 
LLNL Lawrence Livermore National Laboratory
LOS Line of sight
MANA Map Aware Non-uniform Automata
MCCDC Marine Corps Combat Development Command
MCWL Marine Corps Warfighting Lab
M&S Modeling and simulation
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M&S CO Modeling and Simulation Coordination Office
NSS Naval Simulation System
OneSAF One Semi-Automated Forces
RPG Rocket Propelled Grenade
RSAS RAND Strategy Assessment System
TACWAR Tactical Warfare
TOW Tube-launched, Optically tracked, Wire-guided
USMC U.S. Marine Corps
VV&A Verification, validation and accreditation
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